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DISCLAIMER

Care has been taken to confirm the accuracy of the information present and to describe generally 
accepted practices. However, the authors, editors, and publisher are not responsible for errors 
or omissions or for any consequences from application of the information in this book and make 
no warranty, expressed or implied, with respect to the currency, completeness, or accuracy of 
the contents of the publication. Application of this information in a particular situation remains the 
professional responsibility of the practitioner; the clinical treatments described and recommended 
may not be considered absolute and universal recommendations.

The authors, editors, and publishers have exerted every effort to ensure that drug selection and 
dosage set forth in this text are in accordance with current recommendations and practice at the 
time of publication. However, in view of ongoing research, changes in government regulations, and 
the constant flow of information relating to drug therapy and drug reactions, the reader is urged to 
check the package insert for each drug for any change in indications and dosage and for added 
warnings and precautions. This is particularly important when the recommended agent is a new or 
infrequently employed drug.

Some drugs and medical devices presented in this publication have Food and Drug Administration 
(FDA) clearance for limited use in restricted research settings. It is the responsibility of the health 
care provider to ascertain the FDA status of each drug or device planned for use in their clinical 
practice.
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Program License Agreement

READ THIS LICENSE AGREEMENT BEFORE PERFORMING THE INSTALLATION 
OF YOUR SOFTWARE. BY COPYING THE FILES TO YOUR HARD DRIVE, YOU ARE 
AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE SOFTWARE 
ON YOUR HARD DRIVE. RETURN ALL MATERIALS TO YOUR AUTHORIZED DEALER 
FOR A REFUND. 

YOU HAVE PURCHASED A SOFTWARE LICENSE GRANTING YOU THE LIMITED 
RIGHT TO USE THIS SOFTWARE. IF YOU ARE UNSURE OF YOUR RIGHTS 
UNDER THIS AGREEMENT, OR IF YOU WOULD LIKE TO USE THE SOFTWARE ON 
ADDITIONAL COMPUTERS OR TO USE THE PROGRAM CONTENT IN, OR FOR THE 
CREATION OF, A SEPARATE SOFTWARE PRODUCT, THEN PLEASE CONTACT OUR 
LICENSING DEPARTMENT AT stedmans@LWW.com FOR MORE INFORMATION.

Single User License: You have purchased the Software at the Single User License price 
or at a discount of that price. You have a personal, nontransferable, nonexclusive, and 
non-sublicensable right to use the Software on a single-user computer. You may make 
one copy of the Software solely for backup purposes. You may not use the Software in a 
time-sharing environment to provide multiple, simultaneous access. You may not provide 
or permit access to the Software over a value-added network. You may not provide remote 
access to the Software by individuals who are not members of your Institution. You may not 
modify or translate the program or related documentation.

Multi-User License: If you purchased the Software at the Multi-User License price or at a 
discount of that price, you may copy the Software for use within your Organization/Institution 
on the number of computers for which you purchased licenses. You may not provide remote 
access to the Software over a value-added network. You may not provide copies of, or 
remote access to, the Software to individuals or entities who are not members of your 
Institution. You may not modify or translate the program or related documentation. You 
agree to instruct the individuals within your Organization/Institution who will have access to 
the Software to abide by the terms of this License Agreement. If you wish to expand on this 
license, contact Lippincott Williams & Wilkins.

If you or any member of your Institution fail to comply with any of the terms of this License 
Agreement, the license shall terminate automatically. 

The Software and documentation are protected by copyright laws. Unauthorized copying of 
the materials, or incorporation of the Software and/or materials, as part of another product 
is expressly forbidden. You may be held legally responsible for any copyright infringement 
which is caused or encouraged by your failure to abide by the terms of this License.

You may not distribute copies of the SOFTWARE via communications lines or network 
transfers. You may not modify, adapt, translate, reverse engineer, decompile, disassemble, 
or create derivative works based on written materials without the prior written consent of 
Lippincott Williams & Wilkins.

THIS PROGRAM IS LICENSED ONLY TO YOU, THE LICENSEE, AND MAY NOT BE 
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TRANSFERRED TO ANYONE WITHOUT THE WRITTEN CONSENT OF LIPPINCOTT 
WILLIAMS & WILKINS, INC. ANY AUTHORIZED TRANSFEREE OF THE SOFTWARE 
SHALL BE BOUND BY THE TERMS AND CONDITIONS OF THIS LICENSE.

In no event may you transfer, assign, rent, lease, sell or otherwise dispose of the SOFTWARE 
on a temporary or permanent basis except as expressly provided herein.

THIS LICENSE IS GOVERNED BY THE STATE OF NEW YORK AND SHALL BENEFIT 
LIPPINCOTT WILLIAMS & WILKINS, INC., ITS SUCCESSORS AND ASSIGNS. 
LICENSEE CONSENTS TO JURISDICTION IN THE STATE AND FEDERAL COURTS 
LOCATED IN THE STATE OF NEW YORK. 

THE LICENSE IS EFFECTIVE UNTIL TERMINATED.

This license will terminate automatically without notice from Lippincott Williams & Wilkins, 
Inc. if you fail to comply with any portion of the License. Upon termination, you shall destroy 
the written materials and all copies of the SOFTWARE, including modified copies, if any.

LIMITED WARRANTY

Lippincott Williams & Wilkins, Inc. warrants that the SOFTWARE will substantially conform to 
published specifications and to the documentation, provided that it is used on the computer 
hardware and with the operating system for which it was designed. Lippincott Williams & 
Wilkins, Inc. will replace defective media or documentation, or correct substantial software 
or content errors at no charge, provided you return the SOFTWARE and materials, with 
dated proof of purchase, to Lippincott Williams & Wilkins, Inc. within 90 days of purchase. If 
Lippincott Williams & Wilkins, Inc. is unable to correct the problem, the License fee will be 
refunded to you. These are your sole remedies for any breach of warranty. 

Except as detailed above, Lippincott Williams & Wilkins, Inc. makes no warranty or 
representation, either expressed or implied, with respect to this SOFTWARE or 
documentation, including their quality, performance, merchantability, or fitness for 
a particular purpose. Some states do not permit the exclusion of implied warranties, and 
you may have other rights which may vary from state to state.

BECAUSE SOFTWARE IS INHERENTLY COMPLEX AND MAY NOT BE COMPLETELY 
FREE OF ERRORS, YOU ARE ADVISED TO VERIFY YOUR WORK.

In no event will Lippincott Williams & Wilkins, Inc. be liable for general, direct, 
indirect, special, incidental, consequential or other damages arising out of the 
use of or inability to use the SOFTWARE or documentation, even if advised of the 
possibility of such damages. Lippincott Williams & Wilkins, Inc. is not responsible 
for any costs, loss of profits, loss of data, or claims by third parties due to use of, or 
inability to use the SOFTWARE.

YOU MUST REGISTER YOUR LIPPINCOTT WILLIAMS & WILKINS, INC. SOFTWARE.  
Eligibility for support and advisement of updates and enhancements is dependent 
upon receipt of your Registration information and Software serial number online at  
http://register.stedmans.com.  
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Before You Start
Thank You
Thank you for purchasing this Lippincott Williams & Wilkins/
Stedman’s software. Having the right reference tools at your finger-	
tips is essential — and you can’t do better than having Stedman’s 	
at your side.

About LWW Ready Reference Bookshelf v2.2 
The LWW Ready Reference Bookshelf is a robust application enabling 
easy access to the medical reference information you need, when you 
need it. With enhanced features such as multiple search methods and 
customized Add a Topic and Add a Note capabilities, the LWW Ready 
Reference Bookshelf v2.2 provides a turnkey solution in an easy-to-use, 
electronic format.

Review the License Agreement
Before installing the software, carefully review the License Agreement 
included in this User’s Guide. By using the files and/or copying the 
files from the original CD-ROM to your hard drive, you are agreeing 	
to be bound by the terms and conditions of the License Agreement.

Please do not make illegal copies of this software! The software you 
are using was produced through the efforts of many people: designers, 
artists, programmers, distributors, retailers, and other dedicated 
workers. The costs of developing this and other software programs 	
are recovered through software sales. The unauthorized duplication 	
of personal computer software raises the cost to all legitimate users. 

This software is protected by federal copyright law. Copying software 
for any reason other than for backup is a violation of law. Individuals 
who make unauthorized copies of software may be subject to civil and 
criminal penalties.

Before You Start	 �



Using This User’s Guide
We at Lippincott Williams & Wilkins hope that between this User’s 
Guide and the Help screens within the program, you will be able 
to find answers to any questions you may have about LWW Ready 
Reference Bookshelf v2.2. If you still have questions after reviewing 
both the User’s Guide and the Help screens, please contact our 
Technical Support staff. (See the “Technical Support” section of the 
User’s Guide.)

Explanatory Notes 
Explanatory notes offer detailed information specific to your product. 
Please see the product-specific Help Files within your program for 
additional information about the individual product you have installed 
to your Ready Reference Bookshelf. 

Check out www.stedmans.com
Keep up to date with the latest information about all of your 	
favorite LWW/Stedman’s products by visiting us often at 	
www.stedmans.com. There, you’ll get advance word about new 
software, medical word books, and related references. And from 	
time to time you’ll find unadvertised specials available only at our 	
web site, so check back often!

Become a Registered User
Take the time to register your LWW/Stedman’s software. 	
Registration assures you of continued support and notification 	
of upgrades, as well as special offers on new products. Just go to 	
http://register.stedmans.com and submit your information. Your 
registration number can be found on a sticker located inside your 
software packaging.
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Product Activation
LWW/Stedman’s has implemented a product activation process 
for all of our software products. Product activation is a simple, 
one-time process that validates you as an authorized user of your 
Lippincott Williams & Wilkins software. The process verifies that 
your registration number is valid and that the software has not been 
activated on more systems than allowed by the Program License 
Agreement (see p. iii). Product activation does not affect the way the 
program functions.

Why do I need to activate my product? 
The unauthorized duplication and use of personal computer software 
raises the cost to all legitimate users. Product activation seeks to deter 
the illegal copying of software programs (piracy) and unauthorized use 
of Lippincott Williams & Wilkins software, with a minimal impact on 
licensed users.

When must I activate my product? 
Lippincott Williams & Wilkins software products must be activated 
one time, either upon installation or when you first run the program. 
After you have activated your product, you will not need to go through 
the activation process again, unless you switch to a new computer or 
make a significant change that alters the system registry to your current 
computer, such as reformatting your hard drive.

How do I activate my product? 
You may activate your product over the Internet (recommended for all 
users who have an Internet connection on the computer to which they 
install the software), via e-mail, or over the phone.

What if I don’t have an Internet connection? 
If you are installing on a computer that does not have an Internet 
connection, you may activate your product via e-mail or over the 
phone.
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How long does product activation take to complete? 
Product activation is a one-time process that is completed immediately 
before or after installation of the software. Internet activation takes 10 
to 30 seconds to complete. Phone activation takes about 5-10 minutes 
to complete. If you request your activation code via e-mail, please 
allow 48 hours to receive a response.

What happens if I don’t activate my product? 
You will not be able to use your Lippincott Williams & Wilkins 
software until we validate you as an authorized user.

How does product activation work? 
Product activation is required before you can run or install your 
software product. During the product activation process, a small 
amount of information is collected from your computer, including: the 
product name and version; the operating system name and version; 
and your computer’s processor and hard-disk type. This information 
is combined and encrypted, then sent to Lippincott Williams & 
Wilkins along with your Product Registration Number (found on a 
sticker inside your software packaging) for verification. Once this 
information is verified, a Response Code is generated which grants you 
authorization to use the Lippincott Williams & Wilkins program. After 
the Response Code has been transmitted back to your computer, you 
can access the program freely.

Where is my product registration number? 
Your product registration number, which is used to generate your 
Activation Code, can be found on a sticker above the CD inside the 
CD case.

What does Lippincott Williams & Wilkins do with the information 
sent during the product activation process? 
We use the information only to verify that your product is used within 
the scope allowed by the Program License Agreement. The information 
is stored in a database used only for product activation. If you register 
your product, none of the activation information will ever be linked to 
your personal customer information. Please see our privacy policy for 
further information.
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What if I use more than one computer? Can I install the program 
on multiple machines? 
We realize that many of our customers use more than one computer 
in their day-to-day work. With this in mind, the product activation 
process will allow you to use the program on two separate computers, 
with the understanding that you are the primary user of the software 
on both computers. Please refer to the Program License Agreement for 
additional information.

If I install and activate the software on two machines, can more 
than one person use the software on the second machine? 
While you can install and activate your software on two machines, the 
secondary license is for the exclusive use of the primary user. Allowing 
an additional person to use your secondary license is in violation of the 
Program License Agreement.

Do I need to be online to use Lippincott Williams & Wilkins 
software that includes activation? 
Activation is a one-time process. Once you have successfully activated 
your product, you do not need to be online to use your software.

Is product activation the same as registration?
No. Product activation is a mandatory process that must be completed 
before you can use your software. Product registration is a voluntary 
process that ensures that you will be kept informed of new books and 
software, have access to special discounts and offers, receive free 
product support, and more. 

For more information on becoming a registered user, please see page 2. 

If you require additional assistance, or would like to purchase additional 
licenses to use the software, please contact us at stedmans@lww.com.
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Using LWW Ready Reference 
Bookshelf v2.2 with Windows 
2000, XP, ME, NT, and Vista
Program Requirements 
w	 Windows 2000/XP/ME/NT 4.0/Vista
w	 Pentium or higher
w	 256 colors display (thousands recommended) 
w	 800 x 600 or greater screen resolution 
w	 Sound card & speakers (optional)

For specific system requirements for the individual title you have 
installed, please check the Help Files within your program.

Installation from CD-ROM

	 Windows NT 4.0, ME, 2000, and XP: 
To install your new LWW/Stedman’s software:

1.	�Insert the LWW/Stedman’s program CD-ROM into your 	
CD-ROM drive.

2.	From the Start menu, select Run.

3.	�Type d:\setup (where the letter d represents the letter 	
of your CD-ROM drive), then select OK.

4.	Follow the on-screen prompts.

NOTE: This LWW/Stedman’s program requires you to have the LWW Ready Reference 
Bookshelf v2.2 and Java 1.5_05 installed on your computer. The installation program will check 
to see if your computer already has Java 1.5_05 and the Ready Reference Bookshelf installed; 
if not, the installation program installs one or both of these programs, then installs the content 
files for this LWW/Stedman’s program.

Windows Vista: 
To install your new LWW/Stedman’s software:

1.	�Insert the LWW/Stedman’s program CD-ROM into your 	
CD-ROM drive.
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2.	�Using My Computer, navigate to d:/setup (where the letter d 
represents the letter of your CD-ROM drive). 

3.	�Right-click “setup.exe” and select “Properties” from the menu 
that appears.

4.	�Select the Compatibility tab.
5.	�Click the check box next to “Run this program as an 

administrator.” 
6.	�Click Apply.
7.	�Click OK.
8.	�Double-click setup.exe to open the installation wizard.
9.	�Follow the on-screen prompts.

NOTE: When you run setup.exe you will see a standard Vista security screen asking if you want 
to allow the application to run. Click “Allow” to run the program.

NOTE: This LWW/Stedman’s program requires you to have the LWW Ready Reference 
Bookshelf v2.2 and Java 1.5_05 installed on your computer. The installation program will check 
to see if your computer already has Java 1.5_05 and the Ready Reference Bookshelf installed; 
if not, the installation program installs one or both of these programs, then installs the content 
files for this LWW/Stedman’s program

Starting LWW Ready Reference Bookshelf v2.2 

	 From Windows 2000, XP, ME, or NT 4.0: 
1.	Select Programs from the Start menu in Windows.

2.	�From the Programs menu, select the Lippincott Williams 	
& Wilkins program group.

3.	�From the Lippincott Williams & Wilkins program group, 	
select LWW Ready Reference Bookshelf.

4.	�From the LWW Ready Reference Bookshelf Menu, select Launch 
Ready Reference Bookshelf.exe.

	 FROM WINDOWS VISTA: 
1.	�Locate the file “Ready Reference Bookshelf.exe” on your 

computer. The default location is: C:\Program Files\Lippincott 
Williams & Wilkins\LWW Ready Reference Bookshelf (where 
the letter C represents the letter of your hard drive). 

2.	�Right-click “Ready Reference Bookshelf.exe” and select 
“Properties” from the menu that appears.

3.	�Select the Compatibility tab.
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4.	�Click the check box next to “Run this program as an 
administrator.”

5.	�Click Apply.

6.	�Click OK.

7.	�Follow the instructions above regarding Starting LWW Ready 
Reference Bookshelf v2.2 with other Windows platforms.

NOTE: When you run LWW Ready Reference Bookshelf v2.2 you will see a standard Vista 
security screen asking if you want to allow the applications to run. Click “Allow” to run the 
program. Please note that Windows Vista will display this security screen every time you run the 
program. Simply click “Allow” each time.

Creating a Shortcut/Desktop Icon for LWW 
Ready Reference Bookshelf v2.2 
To create a Shortcut/Desktop Icon:

1. �Using Windows Explorer, locate your LWW Ready Reference 
Bookshelf v2.2 program directory. This is typically located at: 
C:\Program Files\Lippincott Williams & Wilkins\LWW Ready 
Reference Bookshelf.

2. �In the LWW Ready Reference Bookshelf program directory, 
you will see a file called Ready Reference Bookshelf with an 
Application file type (exe extension).

3. �Right-click on the file and select Send to Desktop or Create 
Shortcut (depending upon the version of Windows you are 
running). A short-cut icon will appear on your desktop for the 
LWW Ready Reference Bookshelf v2.2 program. Note: It may 
be necessary to drag the file “Shortcut to Ready Reference 
Bookshelf” from Windows Explorer to your desktop.

Quick-Access Hints
Once you have launched LWW Ready Reference Bookshelf v2.2, you 
can quickly access the program from other applications by:

w	 �Using the Alt-Tab keys to toggle from program to program 	
within Windows

w	 �Clicking on the minimized LWW Ready Reference Bookshelf v2.2 
icon on your Windows Taskbar (usually located at the bottom of 
your screen)
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LWW Ready Reference Bookshelf v2.2  
Screen Tour

LWW Ready Reference Bookshelf v2.2  
Menu Bar

File 
The File menu lists the following options:

Print [Ctrl-P]
Prints the current topic.

Exit 
Closes the program.

Edit
The Edit menu lists the following options:

Copy [Ctrl-C]

LWW Ready Reference Bookshelf v2.2 Screen Tour
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�Copies text from LWW Ready Reference Bookshelf v2.2 to the 
clipboard. 

To copy text:

1.	 Highlight the text you wish to copy.
2.	 Choose Copy from the Edit menu or hit Ctrl-C. 

�You can then paste the copied text into your document or another 
application. 

Paste [Ctrl-V] 
�Pastes text that has been copied to the clipboard into the type-in 
box, User Notes, or User-Added Topics.

To paste text:

1.	 �Place the cursor in the field in which you wish to 	
insert your copied text.

2.	 Choose Paste from the Edit menu or hit Ctrl-V.

Preferences 
�Use Preferences to specify how the program information is 
displayed.

�General Preferences — General Preferences allow you to 	
choose how user-added information appears in the  	
program, including:

•	 Display user notes icon in term list. 

•	 Highlight user topics in term list.

�To enable or disable an option in the General Preferences 	
menu, click the check-box in front of the option.

�Products—Under Products, you can modify the order in which 
information from your installed programs appears. For 
example, if you have three LWW/Stedman’s products 
installed in the Ready Reference Bookshelf and a single 	
term appears in all three programs, the Products list 
determines the order in which the information is displayed 
on the screen.

To change the order:
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1.	 Click Products. The Products box will open.

2.	 �Click on the name of the LWW/Stedman’s program 	
you would like to move.

3.	 �Click the Up or Down button until that program 	
is in the position you desire.

4.	 To save this order, click Apply.

5.	 To close the Products box, click OK.

�Appearance—Use Appearance to change the font type, style, 
size, or color for the LWW Ready Reference Bookshelf  
 v2.2 topics. 

To revise the font settings: 

1.	 �Click Appearance or click on the small icon next to 
Appearance to display a full list of available headings.

2.	 �If you clicked on Appearance, click the Change button 
to the right of the heading you wish to modify, or, if you 
clicked the icon next to Appearance, select the heading 
you would like to change by clicking on it. The Fonts & 
Colors box will open.

3.	 �The Fonts & Colors window allows you to change 
font type, style, size, and color. The sample pane at the 
bottom displays a preview of the font as it will appear 	
in LWW Ready Reference Bookshelf v2.2.

4.	 Click Apply to save your changes.

5.	 Click OK to exit Preferences.

Vi ew
The View menu lists the following options:

Back [Ctrl-Left Arrow]
Returns you to the previous topic in your History list.

Forward [Ctrl-Right Arrow]
Moves you to the next topic in your History list.

Index [Ctrl-1]
�Displays the full A-to-Z term list in LWW Ready Reference 
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Bookshelf v2.2.  
To look up a topic in the Index:

•	 �Select Index from the View menu or click on the 	
Index tab or hit Ctrl-1.

•	 �Begin typing the name of the topic in the “Look for” type-
in box. Each time you add or delete letters, the search list 
is updated. You can also use the scroll bar to look through 
the entire list of terms.

•	 �Once you have found the desired topic, hit the Enter key 
(if the topic is highlighted) or click on the topic to display 
the topic information.

�Index Filters—The Index Filters allow you to view a specific set 
of terms from the A-to-Z index. To view only certain topic 
types, choose from the following:

•	 Appendix—Displays a list of the program’s appendices. 

	�S ave Appendices —To save an individual Appendix 
as a PDF file, click the Save button located at the top 
of the screen. A window will open requiring a name for 
the Appendix. The Appendix will be saved to the LWW 
Ready Reference Bookshelf folder unless you specify a 
different location.

	 �Zoom-in/Zoom-out—To enlarge or reduce the size of 
the Appendices, click in the Zoom field located at the top 
of the screen. A drop-down menu will appear. Choose 
Height or Width to fit the page vertically or horizontally 
to the window, or choose a magnification number from 
the list. You can also choose Window to view the full 
page. 

	 �Paging through Appendices—Use the icons at the top 
of the appendix window to scroll forward or backward 
through the Appendices:

�Go to the next page 

�Go to the previous page
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�Go forward 10 pages 

�Go backward 10 pages

�Skip to the end of the Appendix section

�Return to the first page of the Appendix section

You may need to have LWW Ready Reference Bookshelf v2.2 opened to full screen in order to 
access all of the Appendix features.

•	 Abbreviation—Displays the abbreviations found in 	
	 your Stedman’s Dictionary product. 

•	 High Profile—Lists the High Profile terms from your 	
	 Stedman’s Dictionary product.

•	 Generic—Displays only generic drug names in the 	
	 Index list. (Quick Look Electronic Drug Reference only)

•	 Brand—Displays only trade (brand name) drug 	
	 names in the Index list. (Quick Look Electronic Drug  
	 Reference only)

•	 Audio—Lists only those topics that include an audio 	
	 pronunciation. 

•	 Web Link—Displays only those topics that have web 	
	 links. 

•	 Image—Lists only those topics that include an 	
	 illustration or image.

•	 Video—Displays only those topics that have video or 	
	 animations.

NOTE: �Audio files, web links, images, and video/animation are only available in select LWW 
Ready Reference Bookshelf v2.2 products.

Search [Ctrl-2]
�The Search option allows you to search the full content of the LWW 
Ready Reference Bookshelf v2.2 for the criteria you specify. 

�To perform a full text search in LWW Ready Reference Bookshelf 
v2.2:
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1.	 Select Search from the View menu or click on the 	
	 Search tab.

2.	 Type the term you are searching for in the “Search for” 	
	 field.

3.	 Click on the Search button or hit Enter.

4.	 LWW Ready Reference Bookshelf v2.2 will list the topics 	
	 that match your search criteria in the left-hand side of the 	
	 screen. Click on a topic in the list to display the topic 	
	 information. 

Use search commands and wildcard characters to narrow or expand your search results. See 
Search Functions on page 19 for more information.

Search Filters—The Search Filters allow you to search only 
a specific set of terms in the A-to-Z index. To narrow 
your search to only certain types of terms, select from the 
following:

•	 Audio—Searches only topics that include an audio 	
	 pronunciation. 

•	 Image—Searches only topics that include an illustration 	
	 or image.

•	 Web Link—Searches only those topics that include 	
	 web links.

•	 Video—Searches only those topics that have video or 	
	 animations.

NOTE: �Not all LWW Ready Reference Bookshelf v2.2 products include audio 
pronunciations and images.

Search Index [Ctrl-3]
�The Search Index option allows you to perform a search on the A-Z 
index in the LWW Ready Reference Bookshelf v2.2 for the criteria 
you specify.

To search the index in LWW Ready Reference Bookshelf v2.2:

1.	 Select Search Index from the View menu or click the 	
	 Search Index tab.
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2.	 Type the term you are searching for in the “Search for” 	
	 field.

3.	 Click on the Search button or hit Enter.

4.	 LWW Ready Reference Bookshelf v2.2 will list the topics 	
	 that match your search criteria in the left-hand side of the 	
	 screen. Click on a topic in the list to display the topic 	
	 information.

Bookmarks [Ctrl-4]
�The Bookmarks feature allows you to save a list of frequently 
referenced terms. 

To add a topic to your Bookmarks list:

1.	 Look up the topic you wish to Bookmark.

2.	 �With the desired topic displayed on the screen, click the 
Bookmark button at the top of the screen. 

�You can quickly look up topics in your Bookmarks list by selecting 
Bookmarks from the View menu or by clicking on the Bookmarks 
tab at the bottom of the screen. 

To delete a topic from your Bookmarks list:

1.	 From the View menu, select Bookmarks or click on the 	
	 Bookmarks tab.

2.	 Click on the topic you would like to delete. 

3.	 Click the Remove button.

4.	 The Delete Bookmark window will appear.

5.	 Answer Yes to “Are you sure you would like to delete ___ 	
	 from your bookmarks?”

Keywords [Ctrl-5] 
�Use Keywords to access the Indication/Therapeutic Category Index 
(available in Quick Look Electronic Drug Reference only). 

To look up an indication:

1.	 �From the View menu, select Keywords or click on the 
right arrow under the Display Tabs in order to scroll to the 
Keywords Tab. Then click on the Keywords Tab.
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2.	 �Begin typing an indication in the Keywords field or scroll 
through the Keyword list to find the indication.

3.	 �Once you have found the desired indication, click on the 
indication; the associated drug names will appear in the 
box below the Keyword list.

4.	 Click on any drug name to display that topic.

Help
The Help menu lists the following options:

Ready Reference Bookshelf Help 
�The program’s Help Files deliver immediate information about 
features and options for your specific LWW Ready Reference 
Bookshelf v2.2 product(s). 

Product-Specific Help Files 
�The product-specific Help Files include Explanatory Information 
and other information specific to each product you have installed.

About Ready Reference Bookshelf v2.2
Displays the program’s copyright and version information.

LWW Ready Reference Bookshelf v2.2  
Tool Bar

Back [Ctrl-Left Arrow]

The Back button returns you to the previous topic in your History list.

Forward [Ctrl-Right Arrow]

The Forward button moves you to the next topic in your History list.
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Bookmark [Ctrl-4]

The Bookmark button allows you to add a topic or remove a topic from 
the Bookmarks list. For more information on the Bookmarks feature, 	
see page 15.

Add User Topic
Allows you to add a new topic to LWW Ready Reference Bookshelf 
v2.2.

To add a User Topic:

1.	�Click on the Add User Topic button. The Add User Topic 	
window will appear. 

2.	�Select a template from the Select Product drop-down box. 	
A template is listed for each LWW Ready Reference Bookshelf 
v2.2 product you have installed so your User Topics will match 	
the layout and format of the existing topics. 

3.	�Enter the information for your new topic in the fields provided.

4.	�Click the Add button. The Add User Topic window will close.

5.	�To exit the Add User Topic window without saving your topic, 
click the Close button.

User Topics appear alphabetically in the Index list, highlighted in 
yellow.

To edit a User Topic:

1.	Locate the User Added Topic in the Index list.

2.	�Click on the topic. The User Added Topic you selected will now 
appear in the Topic Window.

3.	�Select the Edit User Topic button at the top of the screen. The 
Edit User Topic screen will appear.

4.	Make any necessary changes and click Save.
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To delete a User Topic:

1.	�Find the User Added Topic in the Index list (it will be highlighted 
in yellow).

2.	�Click on the topic. The User Added Topic you selected will now 
appear in the Topic Window.

3.	Click on the Delete User Topic button.

Add Note
Allows you to annotate an existing topic. 

To add a note to a topic:

1.	�Make sure that the topic you would like to annotate is displayed 
in the Topic Window.

2.	�Click on the Add Note button. The User Notes window will 
appear.

3.	�Enter your notes and click on the Save button. The User Notes 
window will close.

4.	�To exit the User Notes window without saving, click the Close 
button.

User Notes appear at the top of the topic, highlighted in yellow; 	
a pushpin icon appears next to the topic’s listing in the Index list.

To edit a User Note:

1.	�Make sure that the topic and appropriate note are displayed 	
on the screen.

2.	�Click on the Edit Note button. The User Notes window will 
appear.

3.	Edit your note as desired.

4.	�Click on the Update button to save your changes. The User 	
Notes window will close.

5.	�To exit the User Notes window without saving your changes, 
click the Close button.
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To delete a note:

1.	�Make sure that the topic and appropriate note are displayed 	
on the screen.

2.	�Click on the Delete Note button in the upper right-hand corner 	
of the screen. 

3.	�When asked if you are sure you want to remove the note, 	
select Yes. 

Print [Ctrl-P]

Prints the current topic.

History
If you have looked up several topics and need to go back to any of 	
them, click on the History button. The History list will show you the 
recent topics you looked up. 

To view the topics in your History list: 

1.	Click on the History button. The History window will open.

2.	�Select the topic you would like to view by double clicking on it 	
in the list or click on the topic once to highlight it and then click 
the Go To button.

3.	�Click on the Close button to exit the History window without 
looking up a topic.
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Search Functions
The LWW Ready Reference Bookshelf v2.2 program has several flexi-
ble search options to help you quickly locate the information you need.

Search Commands 

Use search commands in the Search tab to narrow or expand a search.

& or AND	 Narrows a search by retrieving only those topics that 
contain both keywords in their definitions. Example: 
Type acetaminophen & codeine or acetaminophen AND 
codeine. This search pattern will find all topics that contain 
both the word acetaminophen and the word codeine. 

	 The AND search command is the default Search type. 	
The program will assume that you are using the AND 
search command between multiple terms if no other 
command is used.

! or NOT	 Narrows a search by retrieving topics that contain the 
first word but not the second word. Example: Type 
acetaminophen ! codeine or acetaminophen NOT 	
codeine. This search pattern will find every topic that 
contains the word acetaminophen but does not contain 	
the word codeine.

OR	 Expands a search by retrieving topics that contain 
either the first word or the second word. Example: Type 
acetaminophen OR codeine. This search pattern will find 
every topic that contains either the word acetaminophen 	
or the word codeine.

( )	 GROUP search determines the order or priority of the 
search. Keywords enclosed in parentheses are searched 
first. Example: Type (acetaminophen & codeine) ! Tylenol. 
This search pattern will find any topic that contains 
acetaminophen and codeine, but not Tylenol. 
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Wildcard Searches

?	 Use the single character wildcard (?) to represent a single 
unknown character. For example, if you are unsure of how 
to spell the word Zyvox, type Z?vox to locate the correct 
spelling. 

*	 Use the multiple character wildcard (*) to represent 
multiple unknown characters. For example, if you are 
searching for the word indomethacin and you know it 
starts with indo, type indo* in the Search field. You can 
narrow the search further by adding more letters. For 
example, if you know the word begins with indo and 	
ends with an n, type indo*n in the Search field.

The wildcard character “*” can be used as the first character of a search in the 
Search Index tab only. Also note that only one wildcard can be used per search. 

	 For example, if you are searching for the word 
methyltestosterone and you know it ends in tosterone, 
type *tosterone in the Search field. You can narrow the 
search further by adding more letters. For example, type 
*ltestosterone in the Search field.

Fuzzy Searches

~	 If you are unsure of the correct spelling or would like 
to locate words that sound similar to the word you are 
looking for, you can do a fuzzy search using the tilde (~) 
symbol. For example, if you are looking for a word that 
sounds like aspearaginase, do a fuzzy search by typing 
aspearaginase~. Your search results will find a list of 
possible terms including the correct term, asparaginase. 

Fuzzy searches cannot be used with multi-word phrases. Also, fuzzy searches 
cannot be used in the Search Index tab.
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Multimedia

Listening to Audio Pronunciations
	 �If the topic displayed has an associated audio pronunciation, 

the sound icon will appear at the bottom of the screen. To 
listen to an audio pronunciation, simply click on the sound 
icon.

ACCESSING WEB LINKS
	 �Stedman’s Dictionary products include web links to the 

National Library of Medicine’s Medical Subject Headings 
(MeSH) or the Online Mendelian Inheritance in Man 
(OMIM) database for additional information on selected 
terms. 

	 �If a web link is associated with an entry, the web link icon 
will appear at the bottom of the screen. Click on the web link 
icon and the National Library of Medicine’s Medical Subject 
Headings web site or the Online Mendelian Inheritance in 
Man web site will open in your web browser and take you to 
the entry for your selected term. 

NOTE: �You must have Internet access on your computer to access the National Library of 
Medicine MeSH links or OMIM links.

Viewing Images
	 �If the topic displayed has an associated image, the image icon 

will appear at the bottom of the screen. To view the image, 
simply click on the image icon and the image will open in the 
LWW Ready Reference Bookshelf v2.2 Image Viewer.

Using the Image Viewer
�The LWW Ready Reference Bookshelf v2.2 Image Viewer has the 
following functionality:

w	 �Zoom — Click on the arrow next to the Zoom field to select the 
desired image size.

w	 �Copy—Click the Copy button to copy the current image to the 
clipboard.
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w	 �Print—Click the Print button to print the current image.

�To close the Image Viewer, click on the x in the upper right-hand 
corner of the window.

VIEWING VIDEOs AND ANIMATIONS
	 �If a topic in LWW Ready Reference Bookshelf v2.2 has an 

associated video or animation, the movie icon will appear 
at the bottom of the screen. To view the video or animation, 
simply click on the movie icon.

Using QuickTime Player
�When you open an anatomical video, QuickTime Player is 
launched.  QuickTime Player has onscreen controls similar to those 
found on CD players and DVD players. Use the controls to play and 
pause, to move forward or backward, and to jump to the beginning 
or end of a movie.

�To go to a specific point in the movie, drag the playback head (the 
small triangle) in the timeline. To step through frame-by-frame, 
press the right and left arrow keys on your keyboard.
*�Video instructions adapted from QuickTime Help, “Using QuickTime Player Controls,” 	
http://helpqt.apple.com/qthelpwr1/english/QuickTimeHelp/pgs2/gsFmSet.htm

NOTE: �Audio files, web links, images, and video/animation are only available in select LWW 
Ready Reference Bookshelf v2.2 products.
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Productivity Hints
Shortcut Keys
Shortcut Keys have been built into all of the LWW Ready Reference 
Bookshelf v2.2 menus, so your hands never have to leave the keyboard. 
Just look for the key combination listed next to the function in the 
Menu Bar. For example:

Ctrl-P	 Print

Ctrl-C	 Copy

Ctrl-V	 Paste

Ctrl-Left Arrow	 Go Back

Ctrl-Right Arrow	 Go Forward

Ctrl-1	 Jump to Index Tab

Ctrl-2	 Jump to Search Tab

Ctrl-3	 Jump to Search Index Tab

Ctrl-4	 Jump to Bookmarks Tab 

Ctrl-5	 Jump to Keywords Tab (Quick Look only) 

In addition, look for underlined letters throughout the program. Using 
the key combination Alt + the underlined letter will automatically 
open or access the indicated function. For example, in the LWW Ready 
Reference Bookshelf Menu Bar, File begins with an underlined F so 
if you hit Alt-F the File drop-down menu will appear. (Users running 
Windows 2000 may need to hit the Alt key in order to see underlined 
letters.)

Please see the Help Files within your program for a complete listing 	
of Shortcut Keys for the individual title you have installed. 

Remembering Where You’ve Been
You’ll find that your History list is very helpful when you need to go 
back to a topic that you looked up earlier. Located in the LWW Ready 
Reference Bookshelf Tool Bar, your History list will display all of the 
recent topics you’ve looked up, and you can click on any topic in the 
list to view it again.
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Technical Support
Frequently Asked Questions

	 Q.	 �Do I need to keep the LWW/Stedman’s CD-ROM in 
my CD-ROM drive?

	 A.	 �No, you do not need the LWW Ready Reference 
Bookshelf v2.2 CD-ROM in your CD-ROM drive to 
use the program. The entire program is installed to 
your hard drive.

	 Q.	 �Is the LWW Ready Reference Bookshelf v2.2 
compatible with Windows Vista?

	 A.	 �Yes. Refer to the instructions on page 7 of this User’s 
Guide to run the LWW Ready Reference Bookshelf on 
Windows Vista. 

	 Q.	 �Does the LWW Ready Reference Bookshelf v2.2 
program spellcheck?

	 A.	 �The LWW Ready Reference Bookshelf v2.2 program 
does not function as a spellchecker. If you are 
interested in a medical/pharmaceutical spellchecker, 
please visit our website at www.stedmans.com or call 
our Customer Service department at 1-800-638-3030 
for more information on Stedman’s Plus Medical/
Pharmaceutical Spellchecker (also available in Legal 
and UK editions).

	 Q.	 �I would like to register my LWW Ready Reference 
Bookshelf v2.2 product. Where is my registration 
number?
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	 A.	 �Your registration number can be found on a sticker 
above the CD inside your software packaging. Just 
visit http://register.stedmans.com to submit your 
registration information. 

	 Q.	 �Can I add new topics to LWW Ready Reference 
Bookshelf v2.2?

	 A.	 �Yes, you can add new topics to your LWW Ready  
Reference Bookshelf v2.2 program. Simply follow the 
instructions in this User’s Guide for Adding a Topic. If 
you wish to add information to an existing topic, use 
the Add a Note feature.

	 Q.	 �How do I create a shortcut/desktop icon for LWW 
Ready Reference Bookshelf v2.2?

	 A.	 �Instructions for creating a shortcut icon are included 
under the Installation Instructions in this User’s Guide.

	 Q.	 �Should I uninstall my previous version of LWW’s 
Ready Reference Bookshelf before installing the new 
edition? 

	 A.	 �You will only need to uninstall a previous version of 
the LWW Ready Reference Bookshelf if you currently 
have Quick Look Electronic Drug Reference 2006 
installed on your computer. Users of any other 
products will not need to uninstall their current LWW 
Ready Reference Bookshelf.

	 Q.	 �When I attempt to find a topic in either the Index 
or Search tabs, it doesn’t seem like all of the topics 
appear in the Index List/Search Results.
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	 A.	 �Make sure that you have not selected any Filters, as 
this will limit the number of topics included in your 
Search results. Ensure that the Filtered By field shows 
no filter. 

	 Q.	 �Why don’t I get any results when I use a search 
command [AND, NOT, OR, ( )] or the fuzzy search (~) 
when I’m in the Search Index tab?

	 A.	 Search commands and the fuzzy search can only be 	
	 	 used in the Search tab. Use the table below as a 	
	 	 reference:

	 	 	 Search tab	 Search Index tab

	 	 Search Commands [&/AND, !/NOT, OR, ( )]	 YES	 NO

	 	 Wildcard (?, *)	 YES	 YES

	 	 Fuzzy (~)	 YES	 NO

	 Q.	 �I also have Stedman’s Plus Spellchecker. When it 	
stops on a word, I’d like to be able to switch to LWW 
Ready Reference Bookshelf v2.2 and look up the word. 
Why can’t I do that?

	 A.	 �Stedman’s Plus Spellchecker and LWW Ready 
Reference Bookshelf v2.2 are two separate applications, 
and they don’t work interactively as you describe. 
When you have finished spellchecking your document, 	
you can go back and look up the terms in LWW  
Ready Reference Bookshelf v2.2.
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How to Contact Us
Lippincott Williams & Wilkins is pleased to provide support if you 
need assistance with LWW Ready Reference Bookshelf v2.2. Before 
you contact us, be sure to do the following:

w	 �Refer to the “Technical Support” section of www.stedmans.com, 
or visit www.stedmans.com/help for answers to some commonly 
asked questions.

w	 �If you have encountered an issue with your Stedman’s software, 
write down the sequence of events that led to the problem.

w	 �If an error message is displayed, write down the exact error 
message and error number.

w	 �If you are having a problem working with another application, be 
sure you know the version, and have the user manual handy.

Product Support
If you require product information such as system requirements, or 
have questions about the product’s content or functionality, please 
contact us:

w	 Online: www.stedmans.com/help

w	 Email: stedmans@lww.com

Product Activation and Installation
If you require assistance with or have questions about activating or 
installing your software, please contact us:

w	 Online: www.stedmans.com/help

w	 Email: activate@lww.com

w	 Phone: �1-800-638-3030 US and Canada	
301-223-2300 International
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Technical Support
If you require technical assistance with our products after installation 
assistance, please contact us:

w	 Online: www.stedmans.com/help

w	 Email: techsupp@lww.com

w	 Phone: �1-800-638-3030 US and Canada	
301-223-2300 International

Mailing Address
If you have questions or comments about LWW Ready Reference 
Bookshelf v2.2, send them to us at the following address:

	 Lippincott Williams & Wilkins
	 Attn: Publisher, Stedman’s
	 351 West Camden Street
	 Baltimore, MD  21201-2436
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